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Welcome
Thank you for using CypCut laser cutting control system!
CypCut laser cutting control software is designed for plane sheet machining that
supports editing cutting technique, nesting parts and controlling machining process.
Main functions include graphics processing, parameter setting, cutting process
customization, parts nesting, tool path planning and simulation, and cutting process
control.
Only when use with encryption dog and control card can CypCut realize
machining control.
CypCut will enter the demo mode when running on a computer without
encryption dog and control card. Users can execute all functions except real
machining control. Therefore, users can install CypCut on a laptop for pre-machining
design.

Please note that this manual is only the operation instructions for the main
program of CypCut. For other programs installed with CypCut including config tool
please refer to related manual or contact with us directly.

This document is based on CypCut 6.3.731. Due to continuous updating of
program functions, the CypCut you use may differ in some respects from the
statement in this manual.

If you have any question or advice in usage of our products, welcome to contact
us.
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The working and cutting performance of the machine are
directly related to the material, laser, cutting gas, gas pressure

and the parameters setup. Please be cautious in setting the
parameters!

Improper parameter setting and operation may reduce the
cutting performance, or even cause damage to machine parts
and human body. CypCut system has already provided multiple
protections, meanwhile manufactures and users must follow
the safety operation rules in case of any accidents and injuries.
Shanghai Friendess Electronic Technology Corporation
Limited does not bear any direct, indirect, incidental or
corresponding losses and liabilities arising from the improper
use of this manual or this product.
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1.

Quick start

1.1 Function Features
Support AI, DXF, PLT, Gerber, LXD file format, and standard G code
created by Master Cam, Type3, ARTCUT etc.
Support file optimization includes: remove duplicates, connect unclosed
segments, remove minimal graphic and distinguish inner and outer contour
and set machining sequence automatically. Above functions can be
customized or executed manually.
Support graphic edit functions, including zooming, translation, mirror,
rotation, alignment, replication, combination, etc.
Support set lead line, cut seam compensation, micro-joint, bridge,
inner/outer cut, seal etc.
Automatically distinguish inner and outer contour then determine the
compensation direction and check the lead line.
Support curve split, merge and smooth; transfer text to curve; parts
combination and explode etc.
Automatic nesting can create co-edge and remnant plate.
Users can fill the plate by array function.
Flexible sorting functions. Users can group the graphics to lock the cutting
sequence.
Preview the cutting sequence.
Quick set fly cut path.
Support various piercing methods including segmented pierce, incremental
pierce, pre-pierce, group pre-pierce. Users can also set separate parameters
of pierce and cutting including laser power, frequency, gas, pressure, peak
power, delay, cut height etc.
Real-time frequency and power curve editing. Set slow start parameters.
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Powerful material library function allows all process parameters to be
saved for reuse of the same material.
Breakpoint memory when machining interrupted. And users can select
resume position before or after breakpoint. Support machining selected
graphic.
Users can locate to specified position in stop or pause status and resume
machining.
Support round tube and plane sheet cutting; Support intersecting line
cutting.
Support cutting at fixed height and laser head follows in from outside
plate.1
Support various find edge methods with high precision.
Powerful expansion capacity with 30 PLC, more than 50 programmable
processes. 2
Support programmable input and output port, and alarm input 2.
Support remote control of the system through wireless operator and
ethernet. 3

1.2 Access, Upgrade and Install Software
You can contact the supplier to get the software or directly download on
Friendess company website www.fscut.com.
Before installation, check your system meets the following configuration
requirements:
Win7 and above operating system.
CPU I3 and above.
At least 4 GB memory.
1

This function requires BCS100 controller.
This function requires trained professionals and password credential given by manufacture.
3
Necessary hardware required.
2
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VGA display over 15 inches with resolution 1280*1024 is recommended.
32-bit true color display is recommended.
At least 2 USB interfaces.
If your operating system is based on Vista (including Windows Vista,
Windows 7, Windows 8, Windows 2008 Server), try to run in administrator
to avoid possible errors.
After checking the running environment you can directly install the software.
Under Vista-based operating systems it's required to run as administrator.
To avoid program files modified during installation and ensure all drivers
installed properly, please close anti-virus software like 360 security guards.
Notice: 360 security guard cannot ensure that there is no virus on the computer. If the
computer has been infected by the virus, and 360 security guard is running, it may
prompt CypCut to be a virus, which may lead to CypCut cannot work properly.

1.3 Start Operation
1.3.1 Desktop Shortcut

After installation, the icon

will appear on the desktop. Double-click

can run the CypCut laser cutting control software.
If you are using BMC1204 or BMC1205 PCI control card, please check whether
the encryption dog has inserted into the USB port and running normally. If software
dog detection failed software will enter into demo mode.
If you are using BMC16** and above control card (like BMC1604, BMC1605,
BMC1805 card), the encryption dog has been built in the control card already no
need separate dog.

1.3.2 User interface
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The center zone in black is drawing board, the white frame is the machine
working area. The grid of drawing board and ruler will adjust when zoom the view.
On the main screen from top to bottom is title bar, menu bar and tool bar. You
can find most commonly used functions in tool bar where the function button groupdisplayed with clear icons. The menu bar includes 'File'' menu and other 5 tool menus
'Home', 'Draw', 'Nest', 'CNC' and 'View'. Click the menu will display the related tool
bar. At top left is "Quick Access Bar", which is used to create, open and save files.
Also undo and redo the operation.
On left side is "Drawing toolbar"; the basic drawing functions are provided
here. The first five buttons are used to switch the drawing mode, including selection,
node editing, and sequence editing, dragging and zooming. The other buttons below
correspond to the graphic, click to insert new graphic on drawing board. There are
three keyboard shortcuts at the bottom, which are align center, explode graphic and
add fillet.
On the right side is the "Technique toolbar" including 1 'layer' button and other
17 buttons of different layer color. Click 'Layer' button will open 'Cutting Technique'
window where users can set most of the parameters related with material cutting; 17
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buttons each corresponds with a layer click a button will appoint a layer to selected
graphic; if no graphics selected, click layer color button next time you drawing a
graphic will use it as default layer. Appoint first layer to a graphic, controller will
define this graphic as 'background layer' and not machining. The last and second last
layers are special, the graphics of these 2 layers will be cutting at last or at first. The
second last layer usually used as marking layer.
There are three scrolling text ribbon windows at bottom. On the 'Draw' window
will display all information related with drawing command; On the 'System' window
will display all system information except drawing, each message printed with time
line and marked with different color so users can recognize these message as error,
alarm or notice etc. On the 'Alarm' window displays all alarm messages of red color.
At the bottom is 'Status' bar showing message according different operation.
The left status bar shows graphic message, on the right side displays cursor position,
machining status, laser head position. The rightmost is to fine tune the graphic
position and displaying control card type.
On the right area of the main page is 'Control panel' where users execute most
commonly used machining operations. From top to bottom are coordinate system
selection, manual control button, machining control, process setting and production
counting.

1.3.3 Toolbar
CypCut tool bar displays as Ribbon style that partitions function buttons. The
figure below will help you understand:
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The toolbar is divided into five sub-menu 'Home', 'Draw', 'Nest', 'CNC', 'View'.
Click sub-menu title will switch to the related page; in machining process will show
'Working' page and cannot switch to other page until process stops.
In each sub-menu there are function buttons divided into different region; the
first button in each sub-menu usually in large size for convenient operation; Click
icon '

' will open a dialog box.

The '

' under function button is drop-down menu provide more operation

options. Click the icon and drop-down menu will open different dialog box with
different options.
If you are Office 2007, Windows 7, or other ribbon-style programs user, you
may already be familiar with this arrangement. Even you are first user will like the
style.

1.3.4 File Menu
At top left is 'File Menu' contains options related with file operation click '
' to open the menu:
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On the right column lists the recently opened file you can quickly find the
needed file from the list.
Click 'save as' will save the file as Lxd or Dxf format.
From ‘File-Import’ add file will not clear current graphic. If you just need to
open a file just click File-open.
CypCut V712.6 and above can open the nrp and nrp2 file generated by CypNest
software.
By ‘File-Report’ users can export the machining report, nesting report and
machine running status report.
The menu "User parameters" is used to set some parameters to fit user habit; By
'Backup param' in file menu users can back up all parameter setting in a compressed
file. By 'BCS100 Monitor' in file menu to monitor the BCS100 controller interface;
‘Diagnosis' window in file menu is to monitor and troubleshoot program.
Click 'About' at bottom right in file menu you can check the CypCut software
version information.

1.4 Operation Process

Import

File

Preprocessing

Cutting
Technique

Tool path
planning

Pre-machining
check

Start
machining
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1.4.1 Import File
Click

button on the top left and select the file to open. Preview window

of open file dialog box will help you quick locate the file you need.

You can also draw a part in CypCut, click

and use functions at left toolbar.

1.4.2 Pre-Processing
While importing graphics, CypCut automatically removes minimal graphics and
duplicate lines, merges unclosed lines, automatic smoothing and sorting. Generally,
you can start to set cutting parameters without other operations. If the automatic
processing cannot meet your requirements, you can open the menu "file" - "user
parameters" to set the function options you need.
Generally, the software considers that all the graphics to be processed should be
closed lines. If you open a file containing non-closed graphics, the software may
prompt you message and display them in red color. This function may be turned off.
To view the unclosed graphics on the drawing board, you can click

and

under

‘View ’button in Home menu to highlight the unclosed graphics; you can also select
unclosed graphics by clicking 'Select' and choose 'Select unclosed curve'.
If you need to split graphics manually, click

under "Optimize" drop

down menu and click graphic where you want to split. To merge graphics, select the
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graphics you want to merge, and then click

under ‘optimize’ drop

down menu.

1.4.3 Cutting Technique
You may use most of the functions under "Technical parameter" column in the
Home menu bar, including setting lead lines and compensation, etc. The large size

button

used to set lead lines, and the button

over-cut, gap or seal parameters. The button
compensation. The button

is used to set

is used to set a micro-joint that will not be

processed on the object. The button
direction of a single object selected. The button
point. Click

used to set the

is to reverse the machining
is to set the cooling

button, then point on the graphic where you want the

cutting to start at will set a start point. If you point outside graphic then point to the
graphic will set a lead line.
You can press Ctrl+A select all graphic, click 'Lead' set parameters then program
will set lead line automatically. Click 'Lead' drop-down menu select 'Check', program
will check if lead line cross with graphic or in wrong direction and optimize the
result.

Click button

on the right toolbar to set the detailed cutting parameters. The

layer parameters setting dialog box contains almost all the parameters related to the
cutting performance.
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1.4.4 Cutting Path Planning
Set the cutting sequence of graphic as needed. Click

in Home or Nest

column will automatically set the cutting sequence of all graphic. Open drop-down
menu you can choose sorting pattern, and recognize inner and outer contour of the
parts graphic.
You can also choose Manual sort to optimize the auto-sort result by click

on

left toolbar, then click the graphic to set the sequence. Click one graphic and click
next will define the cutting sequence of these two graphics.
Select the graphics have been sorted (set sequence) and click

button in

Home menu will set a group. The sequence of the graphics within a group will be
fixed. And the group will be defined as a whole object.
Right click a group and select group sort you can modify the sequence of the
graphics within a group.

1.4.5 Pre-Machining Check
Users can check the tool path before start machining. Click Align button will
align the graphic; drag the Progress bar will quick show the graphic sequence; click
Interactive preview button can check the sequence one by one.

Click

button on console panel program will simulate the machining

path and machine not running. Users can adjust simulation speed in
menu.

sub-
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1.4.6 Start Machining
Please take notice that it requires compatible control card and dongle to actually
realize machining.
Before start machining it has to match the position of graphic and machine bed.
Click

button on the left side of the control panel will show the position of

graphic on machine bed. This position is calculated by the reference mark location on
the screen and the laser head position at machine. There are some symbols on the
screen, click 'Preview' the 'Reference' mark will move to the laser head position.

If the Red Cross does not match the real position of laser head, please check the
mechanic origin and correct the origin by CNC-Return origin. If click 'Preview' and
graphic is partly or fully outside the white frame, it means machine will exceed the
travel range.
Click

in Home menu can modify the reference position of the graphic.

For example, if laser head is at left bottom of the graphic then set the reference as left
bottom.
After check the position, click

on control panel, laser head will

move along the rectangular frame of the graphic, you can check if the machining area
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on machine bed is right. You can also click

to simulate the whole

machining path on the machine bed without laser/gas to check if there is improper
process.
Click

start machining, Click

pause the process and you

can manual control laser head up and down, open or close laser and gas etc.; In pause
status users can click
the graphic path. Click
Click

to move forward or backward along
resume the machining process.
end the machining process. Laser head will return to the pre-

set position. If you didn't change graphic or start new machining process, click
will locate to the break position where last machining was end and click
start machining from break point.
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2.

Graphic Edit

2.1 Graphic Display
In Home menu -'View' column provides various options of graphic display.
Click the option button it will take effect immediately and you can see the
display effect change on the screen. The option button shows in yellow indicates the
option enabled. If the option button not in yellow color means function not enabled.
For example,
close

is enabled, graphic will show the cutting path with arrow symbol,

the arrow symbol disappear.

When ' Show Micons' opened, you can see the white mark at position where you
add micro-joint:

When you click

the graphic will show in the center of the white

frame.

Click

right down

button will open an option box providing detailed

setting options where allow users to open or close graphic absorb function, ruler etc.
Scroll the mouse on the screen will zoom the view. Click F3 will center all
graphic on the screen, click F4 will center the machine frame on the screen. Right
click mouse will prompt option box, select zoom you can also execute same
operations above.
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2.2 Selection
CypCut provides various ways to select graphics. The basic operation is 'Click',
click the graphic will select it. Another commonly used operation is 'Frame', drag the
cursor on the screen will create a frame box. There are 2 patterns of 'Frame': Press
and hold from left to right will create a blue box, only when a whole part was framed
in the box will be selected. From right to left will create a green box, as long as part
of the graphic was framed in the box, the whole graphic will be selected.
The 'frame' effect of these 2 patterns shown below. Left image is effect framing
from left to right, 'BC' will be selected; right image is effect framing from right to
left, 'ABCD' all selected. It’s flexible to select graphic by these two patterns.

Press Shift when select graphic you can select or deselect graphic without
changing the select result of other graphics.
Click ' Select' will open a drop down menu providing more options:
Basic operations: Select all (Ctrl+A), Invert, Copy (Ctrl+C), Paste
(Ctrl+V), Cut (Ctrl+X), Deselect, Copy with base point.
Graphic operations: Select unclosed graphics, select similar graphics,
select inner/outer contour, and select graphics smaller than specified size.
Layer operations: Select the layer (used to select all the graphics in a layer)
and lock the background.
'Disable Drag and Copy" will disable the operation that press Ctrl and drag
the graphics to duplicate graphics. This will prevent the malposition of
nested graphics.
'Select similar graphic' will select all graphics with same shape. For example,
select a circle of 5mm radius, then click this option will select all circles of 5mm
radius.
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2.3 Geometric Transform
'Geometric Transform' under Home page provides abundant functions of
transforming geometry including mirror, rotate, align and zoom
etc.

2.3.1 Size Modification
CypCut provides 7 options under 'Scale' drop down menu
to quick modify the graphic size. Pictured as right:
For example, '100mm' will zoom the width of graphic to
100mm in scale, '2 Times' will scale-up graphic 2 times in size.
If you want to input an accurate dimension, click Scale
button will prompt the below dialog box. Input new size and click Ok to finish the
size modification.

If the lock icon in this state

, the scale of length and width is coupled, if

you want to modify the length and width separately click the icon
.

turn to state
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"Scale center" specify the position between new graph and the original one. For
example, “Top left" indicate the graph in new scale at the top left of the original one.
Notice: The lead lines and seam compensation etc., will not change with the size
modification.

2.3.2 Dynamic Transform
CypCut provides 3 patterns of dynamic transform including dynamic scaling,
rotating and mirror. First select the graphic and click transform button then follow
operation tips at screen bottom.
For example, to rotate a rectangle 45°in the base line of left bottom, you can
follow the operations:
1) Select graphic.
2) Click transform drop down menu select 'Rotate', at bottom window will
prompt 'Please specify base point:
3) Move cursor to the right corner, cursor will absorbed to the rectangle corner
automatically:

4) Click the corner, bottom window will prompt 'Please specify the start point
or rotation angle:'
5) Input 45 and click Enter will finish the operation.
If you want to rotate the rectangle and align with another graphic, first step same
with above, then follow the below steps:

Friendess CypCut Laser Cutting Control System

6) Click the right corner of rectangle will create a base line.
7) Bottom window prompts' Please specify end point of rotation" meanwhile
move cursor graphic will rotate and click mouse at target position. As
shown below:

Dynamic mirror operation same with the rotate.

2.3.3 Translation and Copy
You can quick translate the graphic with direction button. First click
button at the right bottom of the screen to enable the function
. Activate the button then you can input the fine tune
parameter. Select a graphic click the direction button it will move at this direction and
in fine tune distance. This function used to move away a graphic temporarily and
move back the graphic exactly where it was. Press Ctrl button and direction key in
the same time will duplicate the graphic. For example, press 'Ctrl+right ' buttons
will duplicate the selected graphic at the 100mm right side of the original one.

2.4 Coordinate and Parameter Input
In some cases, users need to draw graphic at an accurate coordinate. In CypCut
users can input coordinates directly. Input format is< X coordinate><comma,><Y
coordinate>. For example, the coordinates (100,100) input in CypCut is
"100,100".The input coordinates and parameters are shown in blue.
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Most of the drawing operations allow both mouse click a position and
coordinate input. The following steps show you how to draw a rounded rectangle of
length 300mm, width 200, fillet radius 25mm.
1) Click

button at left toolbar, meanwhile bottom window will prompt

'Please specify start point'.
2) Input '0, 0’ press enter, then prompt' please specify cross point'.
3) Input '300,200' press enter, prompt' please specify radius'.
4) Input 50 press enter. All operations are completed. As shown below.

2.5 Automatic Adsorption
The drawing operation will activate the automatic absorption, including absorb
to the grid, graphic key point, absorb to graphic boundary etc.
You can close the automatic absorption function in
, in 'Drawing' page deselect the

menuoption. You

can also set absorb precision in this dialog box.

2.6 Graphic Drawing
CypCut provides graphic drawing function. On the left toolbar from top to
bottom is: Isolated point, straight line, poly line, circle, arc, rectangle, polygon, text,
standard parts. The first 5 functions are standard drawing functions similar with
CAD.
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2.6.1 Standard Graphic Drawing
Drawing isolated point, line, poly line, circle, rectangle are easy to operate will
not put details here. There are two options under Draw - circle drop down menu:
‘Replace circle as point' and 'Replace by circle’. This function can replace circle
as isolated point or replace graphic as circle.
In Polygon drop down menu there are rounded rectangle, polygon and star
shape. To draw a rounded rectangle you have to draw a rectangle first then specify the
fillet radius or directly input fillet radius in bottom window; To draw a polygon or
star shape, you have to specify the number of edges (from 3 to 100);The number of
edges for star shape is the point angle number. Besides, in Draw menu, under

there is Obround shape option, the way to draw Obround similar with
rectangle, then add a semicircle to both ends of the rectangle.

2.6.2 Text Input
In CypCut users can input Text and transfer text into curves. Click

in

left toolbar and point at screen to insert text.
Select text there will be a 'Text' column at the top toolbar, users can modify the
text, type and size etc., as shown below:

Please take notice that after transfer text to curve above functions will be not
available. After you finish all design and settings of the text, transfer the text to curve
at last operation.
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2.6.3 Standard Parts
There is standard parts library in CypCut.Click

button on left toolbar you

can draw commonly used parts. Select the part shape then set the parameters. As
shown below:

2.7 Measure
CypCut provides a tool for measuring the distance between two points.

Click

button and select a point on drawing board then click another

point, bottom window will show position message between these 2 points.

2.8 Graphic Optimization
CypCut will automatically optimize the file. Under Home- Optimize drop down
menu users can manually select optimize options.
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Select graphic, click option and follow the hint finish the operation.

2.8.1 Smooth
Select the poly line need to optimized then click

button, dialog box

will prompt users to input smooth precision, click enter will take effect.
The smooth result shown below. This result get by input a large precision value
so it's easy to observe the smooth effect. Users can set the smooth precision as
needed.

2.8.2 Split
Split function is to break the graphic of closed curve and split as separate
graphic for editing. Click

at the split position. The split function will be

activated until press ESC to disable the function or switch to other command.
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2.8.3 Remove Trivial
Sometimes the imported graphics may contain visually imperceptible graphics,
resulting in an abnormal position in machining. Users can use this function to remove
these minimal graphics by setting the dimension range to define the minimal
graphics. Graphics smaller than dimension range will be removed.

2.8.4 Remove Duplication
This function used to remove the overlapped line on the closed contour.

2.8.5 Combine Near
The graphic created by AutoCAD might be visually closed contour but not in
fact. Users can use this function to combine unclosed contour. Select the unclosed
contour and click

, input combine precision.

Please take notice that there might be excess line at geometry end, split and
remove the excess line then combine the contour.

2.8.6 Chop
This function is to add cut lines at in part holes to prevent tip-up collision. The
cut lines in white color to be different with part graphic.
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2.8.7 Plate Separate
To divide a graphic drawing in several parts to fit the machine working area.
Partitioned drawings framed by red box need to be saved separately.

2.9 View
Users can zoom and edit graphic, adjust graphic position and sequence etc.
Function entry is on the top of the left toolbar. From top to bottom is select, node
edit, manual sort, pan view and zoom.

2.9.1 Node Edit
CypCut provides node editing function for fine-tuning graphics. Select graphic
and click
Click

you can see the nodes of the graphic. Drag a node to adjust the graphic.
again will disable the function.
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Nodes in blue and yellow both are editable.
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3.

Graphic Technique and Tools
This chapter describe the functions relate with cutting technique. Users need to

set the parameter according the material, laser, gas etc., which are directly involved in
the cutting technique. All parameters should be considered as reference not a guide
value.
Warning! Improper or incorrect parameters may result in bad cutting
performance even damage the machine.

3.1 Lead Line
3.1.1 Distinguish Inner and Outer Contour
CypCut will distinguish the inner and outer contour automatically when import
external file like DXF. Inner and outer contour will reverse in editing the graphic. If

you need to distinguish inner and outer contour again click

, select in drop down

menu 'distinguish inner and outer contour when sorting' or click 'Distinguish inner
and outer contour' under 'Lead' drop down menu.
CypCut distinguish the inner and outer contour by the boundary relations. It will
define the outmost contour as outer contour, the second is the inner contour, the next
is outer contour, and unclosed graphic will not be defined as a contour. If you want to
set one contour as outer contour, select the contour and contour within as a group.
Then right click use group sort will distinguish the inner and outer contour.
When add lead lines, outer contour cut from outside, lead line add to inner
contour will start from inside. Click
manually set inner or outer contour.

in Home menu you can
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3.1.2 Automatic Lead Line

Select the graphic will and click

under Home menu. Set the parameters

like below image:

Users can add different type of lead line including straight line, arc, straight line
and arc, and other settings including lead angle, length and radius. You can also add
little circle at lead line start point.
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When select lead line as arc type, the end of arc will be tangent with graphic.
The line connects arc two ends form the angle with graphic boundary. The lead-out line
is similar to this.

Please take notice that executing auto-add lead line will change the previous
setting. You can select

to fix the lead line position.

3.1.3 Manual-set Lead Line
Click

to change the lead-in line manually. Click on graphic only

change the lead in line position, lead length and angle remain same.
Click outside the graphic then click back on graphic will create a new lead line.

3.1.4 Check Lead Line
Click 'lead' drop down menu and select 'check lead line'. This function will
examine all lead line and adjust lead line length if it's too long and cross with graphic.
Click 'distinguish inner and outer mold' it will examine all lead lines and adjust lead
line direction according the lead line is add on inner or outer contour.
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3.1.5 Overcut, Gap, Seal and Multi-cut

There are 4 options

in technical parameter column. Select

graphic and click function button will take effect. The 'gap/overcut' setting will not
take effect to the graphic already set gap or overcut.

3.2 Seam Compensation
Select graphic and click

in toolbar to add cutting seam

compensation.
Seam compensation should be accessed by measuring real cutting result. The
compensation displayed in white on drawing board. Machining will refer
compensation line as tool path. Original graphic still display on drawing board but
not as actual tool path.
The compensation is inside/outside contour can be set manually or
automatically.
Users can also add fillet on compensation line at corner like below photo:
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In the photo, the line of green is original graphic, white line is compensated
path. It requires smoothing at corner. Usually round corner will smooth the
machining path and assure the consistence of graphic and cutting result.
Users can edit compensation parameter and build a library in compensationconfiguration-edit.
To remove the compensation you need to select graphic first then click

drop down menu select 'clear compensation'.

3.3 Micro-joint
Micro-joint is to add a small distance joint on the graphic. Laser will not fire on
the graphic where add micro-joint. By doing this parts will not fall from the plate
skeleton also prevent tip-up collision. Micro-joint displayed as a breach on the
drawing board:

Click

in technical parameter column to activate the function

then click on the graphic where need to add micro-joint. You can click multiple times
to add more than one micro-joint until press ESC or switch to other command. You
can also click on the compensated line to add micro-joint.
Micro-joint length setting will not change the previous set micro-joint.

35 / 103

36 / 103

Friendess CypCut Laser Cutting Control System

You can also add auto micro-joint. Click
select

drop down menu and

will prompt a dialog box for parameter setting. You can

add by micro-joint count, for example, if set 10, each graphic will add 10 microjoints; or by distance, set 100 it will add a micro-joint every 100mm interval.
Micro-joint will divide the graphic into separate segments. If you want to edit

each segment separately, select

in drop down menu.

After execute 'explode micro-joint', each segment is an individual object to edit, you
can add lead line on each segment.
To delete micro-joint, select the graphic then click 'Clear micro-joint' under
'Clear' drop down menu.
CypCut V731 and above adopts FlyCut strategy cutting micro-joint segment, the
laser head will not lift up and pass the micro-joint segment without slowing down,
which will increase the machining efficiency.

3.4 Cooling Point
Click

button then click on the graphic will add a cooling

point. When the machining executes cooling point, it will turn off laser and open gas
maintain a preset delay, then open laser turn off gas and resume normal machining
again. The cooling point is shown as a solid point white dot in the drawing board as
follows:
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Like micro-joint, the cooling point can be clicked continuously to insert more
than one. After you finish setting micro-joint and compensation can still add cooling
point.
CypCut can also add cooling point automatically. Click

drop down menu and select 'Auto cooling point' and set
parameters in dialog box. There are two positions users can select to add cooling
point automatically: sharp corner and lead line. The cooling point add on lead line
will integrate with lead line. For example, if click 'Clear cooling point' will not delete
the cooling point on lead line. Only delete lead line can remove the cooling point add
on lead line.
Press shift and click cooling point you can delete it. If you want to delete
cooling point, click drop down menu of cooling point and select 'clean cooling point'.
Cooling point is often used in processing workpiece corner, it will pause at
cooling point, turn off laser and gassing to lower the corner temperature avoid corner
burned.

3.5 Ring Cut
Select graphic and click
corner cutting performance.

to create an extra path to improve sharp
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3.6 Fillet/Release
Click
Click '

to transfer sharp corner into rounded corner.
to create a release notch for bending process.
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3.7 Group
Group function in CypCut is to integrate multiple graphics as a group. A group
will be recognized as an independent object. The sequence and position of the
graphics within a group are all fixed and will not change by other operations.

Select the graphics and click

group, select the group and click
drop down menu of group and select

will create a group. If you need to disperse a

. If you need to disperse all groups click
.

'Degroup' will not disperse the graphics only the group. 'Explode graphics' will
disperse the graphics as line segments.
'Multi contour cut together' will create a path connect the group which will
reduce the piercing times and improve the efficiency. 'Explode multi contour cut' will
clear the connecting path.
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For a group, if there is one graphic contains all other graphics, this graphic will
be defined as outline. The group with outline will be defined as a 'part'.
It's recommended that CypCut users create 'Group' to integrate a part not just
group graphics randomly. We might use term 'part' same concept as 'group'.
CypCut will integrate co-edge graphics as a group. In addition, use 'Bridge'
function to connect a group with other group the result will be a group.

3.7.1 Sorting of Group
The group will be defined as an independent object in sorting. The sequence of
the graphics within a group won't change in sorting.
If you need to edit sequence of graphics within a group, select a group and right
click, select 'group sort'.
‘Group sor’ operation will not change the sequence of graphics in sub-group. It will
distinguish inner and outer contour of graphics within a group by geometrical
relations.

3.7.2 Machining of Group
Group will be defined as an independent object, until a group is fully processed
it will not move on to the next graphic. Piercing of group follow the same rule.
Please take notice that the outmost contour of a part/group will always be
processed at last.

3.8 Flying Cut
When the graphics are standard shapes like rectangle, circle or polygon and
layout in principles, you can use flying cut function to improve the machining
efficiency.
Before use flying cut, execute sorting first, this will optimize the cutting path.

Click drop down menu of

select flying cut patterns and set parameters.
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Start position defines where to start flying cut. Max joint distance: it will create
a smooth cutting path to turn around if the turning distance is shorter than this value.
Max scan length: if the distance between two graphics longer than this value it's not
able to create fly cut path.

When the graphics in a layout are all circles, select 'Circles flying cut' pattern.
Max distance between two circles: only the distance between two circles shorter
than this value can create fly cut path.
Select
select with '
process next group.

will execute sorting first then create fly cut path, if
it will process the graphics within a group then
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Select

only, it will execute sorting then create fly cut path.

In global parameter page, set a fly cut over-cut distance will assure parts will fall
down from skeleton plate.
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3.9 Co-edge
Merge the shared line of two parts as one
will reduce the cutting length. In CypCut, the
parts of space smaller than 0.1mm can use coedge function. CypCut provides graphic absorb
function to snap two graphics and merge the
shared lines.

Select the graphics and click

, it

will merge the shared lines of the selected
graphics.
CypCut cannot merge the inward concave
lines of the graphics.
The graphics merged shared lines will be integrated as a group. If the graphics
which are going to merge the shared lines contains other graphics inside like circles,
you have to group the graphics first.

3.9.1 Automatic Absorb
When drag the graphic, it
will attach to another graphic
automatically when in the
position fit for co-edge. Absorb
function will help you quick
adjust the position of graphics fit
for co-edge.
Once graphics attach with
each other with shared lines, click
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will create the co-edge. If you want to disperse the graphics with co-edge,
click 'explode graphics' under 'group' drop down menu.

3.9.2 Co-edge with Compensation
If you want to add cutting seam compensation to the graphics, you have to add
compensation first then execute co-edge. The graphics of co-edge add compensation,
then only compensation line remained.

For example, in the above picture, graphic P is the compensation line of the
graphic A, only graphic P can co-edge with graphic B because graphic A is not real
cutting path.

3.10

Bridge

When a workpiece contains several parts and you want to keep them connected,
you can add bridge between graphics. And graphics with bridge also reduce the pierce
times.

Click

and drag a line segment on the drawing board, the graphics cross

with the line segment will be bridged like below image.
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There are two parameters to define the bridge function. One is the max distance
between two adjacent graphics, only the distance between two graphics smaller than
this value can add bridge. The other is the width of the bridge.
The graphics add bridge will be recognized as group, please be careful that the
continuous cutting will cause heat affect to cutting quality.

3.11

Array

The 'Array' function used quick duplicate a graphic, there are 4 patterns of Array
in CypCut.

3.11.1 Rectangular Array

Click

under Array drop down menu will prompt the below page:
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Set the lines and columns of the array will duplicate the selected graphic.

3.11.2 Manual Array
Select 'Manual Array', set the line space and column space, drag the cursor will
duplicate the selected graphic.

3.11.3 Circular Array
This pattern will duplicate the graphics in a center and create a circular layout.
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3.11.4 Full Fill
This pattern is used to duplicate the graphic and cover the whole plate by pre-set
plate dimension.

3.12

Quantity Modify

To edit a graphic and apply the result to all graphics same with this graphic, you
can use quantity modify.
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Select the graphic and click

in Home menu will open the

quantity modify window, if you set lead line to the graphic, it will apply to the
graphics same with the current graphic.
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3.13

Cutting technique

There are 16 layers in CypCut, users can set the cutting parameters to each layer
including cutting speed, laser power, gas pressure and nozzle height etc. The last two
layers are 'process at the first' and 'process at last'.
Click 'Layer

' in Home menu will open layer parameter window contains

almost all parameters related with machining. The first page is 'Global parameter'
used to set default parameters used universally in machining. The other pages list all
the layers applied, click the layer page to set the parameter of this layer.
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Notice: The parameter options may differ for different laser source and gas
configuration, the parameter in the image can only be reference, users must set the
parameters by actual software display in your own machine.

3.13.1 Parametric Description
The following table gives a brief description of some of the parameters in the
layer.
① Basic parameters
Cutting speed

Set the target speed of actual cutting. Because of the acceleration
and deceleration in machining workpiece corner, the actual cutting speed
is usually slower than the set value.
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Lift height

After process a graphic segment laser head will lift to this height
and move to next start point. When pause the machining, laser head will
lift to this height.
② Machining mode

Standard

Machining will follow the preset parameters.

Fixed height cutting

Laser head will be at a fixed height in whole cutting process.

Extra plate follow

Select this mode, the laser head will start outside the plate and follow
to cut height once move within the plate.
Locate laser head at a suitable position, in CypCut-CNC-BCS100-Save
extra-plate follow reference height set the parameter.
③ Machining parameters

Cut height

Set the following distance between nozzle and plate.

Gas type

Set the type of auxiliary gas used in cutting.

Gas pressure

Set the pressure of axillary gas in machining, this requires
proportional valve.

Peak power

Set the peak power of the fiber laser. Peak power determines the
maximum cutting power that the machine can achieve. If the peak
current is set to 80%, the maximum cutting power is 3000W * 80% =
2400W.

Cut pwr

The duty cycle of PWM modulation signal.

Cut Freq

The frequency of the PWM modulation signal which is the times of
laser fires within 1 second.

Cut Focus

The position between focus with nozzle tip.

Delay Time

The duration of laser firing to confirm laser cut through the
workpiece at the start.

Laser-off delay

A delay before turn off laser.

Step time

Set the time required that laser head descends from pierce height to
cut height.
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Extra puffing

After finish pierce actions, it will turn off laser and open gas to cool
down the material temperature.
④ Other parameters

Disable

This layer is not going to be processed.

Disable follow

When machining this layer it will close follow function, laser head
will be at a fixed height.

Keep puffing

Gas is open in the whole machining process.

Short move

This function related with the 'Move optimization in short move'
parameter. If the distance from one graphic end point to next graphic
start point shorter than this value, Z axis will not lift up on this path.

Pre-pierce

It will pierce at all graphics start point or lead line then start cutting.
In 'Global parameter' window there is 'group pre-piercing', enable this
function it will execute pierce of one group and complete machining of
this group then move to next one. Notice: pre-pierce cannot be selected
with evaporative film.

Evaporate film

It will execute filming parameters along the graphics then start
cutting. After you select this option there will show a evaporation layer
page.

Path cool

After finish machining of one graphic it will turn off laser and
blowing gas along the graphic to cool down the material reduce the heat
effect to the workpiece precision. After you select this option it will show
a Cool layer page.
⑤ Slow lead

Length

This used in cutting thick material, it will start cutting in a slow
speed to make sure plate cut through.

Speed

The speed in this start length.
⑥ Power curve
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Real-time

After you enable this function you can edit the power/frequency

power/frequency

curve, and program will regulate the laser power and frequency

regulate

according the curve. This function is very practicable improving corner
precision. Notice: 'Dymc freq adjust' cannot select alone.

3.13.2 Real-time Power/Frequency Regulate
If select

the laser duty cycle and frequency will

regulate with speed in real time. You can click the

button to edit the

power/frequency curve.

As shown in the photo above, horizontal axis us speed, vertical axis is
power/frequency, unit is percentage. You can select the curve pattern and set the
power level when machine reaches a specified speed. You can click
copy the power curve to frequency curve. Notice: Only when
enable 'Dymc pwr adjust' curve select 'dymc freq adjust' will take effect.
For example, laser power 500W, peak power 90%, cut power 80%, when the
actual speed slow down to 29mm/s, the laser power is:
500W X 90% X 80% X 79.00% = 284.4W
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The power will not be lower than 10% of the laser power, for example 500W
laser will not lower than 500*10%=50W.
If not select

, the cut power will remain not

change in cutting process. In the above example, if not select these two options, the
power in the cutting process is 500 W X 90% X 80% = 360W.

3.13.3 Layer Mapping
Click 'Layer' drop down menu users can lock or display a specified layer by
select options. When there are more than one layers when import DXF file, click
'layer mapping' it will distinguish layers. Shown as below:

3.13.4 Lead Line Technique
When cutting thick plate of stainless steel will generate plasma cloud which will
absorb laser energy and reduce cutting energy, gas can hardly blow off the plasma
cloud at cut height. Lead line technique is applied to solve this issue. After execute
pierce, laser head will stay at a higher position and blow off the plasma cloud, then
slow the speed in horizontal direction to make up the pressure loss.
When cutting thick plate you can set lead line technique including speed,
power, lead height and stable distance.
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The actions process lead line:
1.

Pierce at start point of lead line;

2.

Laser head lifts to the lead height to blow off plasma cloud;

3.

Laser head descent to the cut height and cut at 'lead speed' in the length of
'stable distance';

4.

After cutting out of the stable distance it will start normal cutting.
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Nest

Nest function is used to layout the parts in a plate with highest utilization. Users
can click nest button to finish nesting. CypCut also provides options to customize the
nesting like: Parts gap, plate margin, rotation angle, co-edge and remnant

management etc. You can find nest function button

in Home menu and Nest

menu.

3.14.1 Nesting
In nesting operation there will be a side bar at left screen to display the parts,
plate and nested plate.
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Parts library will list all parts, you can add new parts by right click at parts lib
and select 'load parts', or you can select parts at drawing board right click the part
select 'add to parts lib'. The parts type limits is 50.Right click at side bar you can
choose to import standard part, delete part or save un-nested parts.
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Plate library lists the plate and plate quantity, you can add new plate same
operation with adding parts. Right click side bar you can choose to delete plate or
save as file.
Nest plate lists all nested plates and already processed plates. CypCut now only
supports 20 plates nesting at one time.
Users need to set basic parameters for nesting. 'Part gap' is the minimum space
between parts; 'Plate margin' is the plate margin left when nesting; 'Nest strategy' only
supports array in CypCut.

In 'detail settings' you can set parts rotation angle allowed, layout direction, coedge and remnant material management.
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3.14.2 Nesting Report
In 'Nest plate' list right click the plate select 'generate report' and finish the
setting about pricing then click 'generate report', it will prompt layer window, the
layer parameters used to estimate the cost. As shown below:
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3.14.3 File Switch
Open nrp or nrp2(file package generated by CypNest nesting software), it will
list all nested plates, also processed times and planned process times. The processed
times will add up after the current plate task finished machining. When the processed
times reach the planned times it will switch to the next file.
Software version required: CypCut V712.6 and above

3.15

Sorting and Path Planning

The below function column is in the 'Draw' menu which list all sort patterns and
align tools.

If no requirement to the sorting result, just select 'grid sort'.
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3.15.1 Sequence Preview
Drag the progress bar or click

you can preview the machining sequence of

the graphic. Below picture shows graphic status when preview sequence:

Sequence preview is completely interactive, easier to control the progress forward or
backward. You can view the move path to check the overall sequence. Open 'View'

drop down menu select

.

3.15.2 Manual Sorting
If you want to adjust sorting result, you can manually edit the graphic sequence. Select
graphics then click

, the buttons from left to right is:

First

The selected graphic will be the first to process.

Last

The selected graphic will be the last to process.

Prior

Adjust the sequence of the selected graphic one step forward.

Next

Adjust the sequence of the selected graphic one step backward.

After finish sorting, you can click

to check the sequence one by one.
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You can open 'Manual sort mode' to edit the sequence. Click

on left bar of main

screen will enter 'manual sort' mode. It will display the graphic sequence and path.
Click graphic one by one as you required sequence. If one graphic click accidently,
click this graphic again or right click to cancel the operation. If you just want to edit the
sequence between two graphics, just click a graphic drag a red line to the other graphic will
set the new sequence of these two graphics.

3.15.3 Group Sorting
If you want to fix the sequence of certain graphics, you can group these
graphics. The sequence of the graphic within a group will not change in other sort
operation. When process the graphics within a group, it will not process other
graphics doesn't belong this group till the group is finished.
If you only want to sort a certain graphics, group these graphics and use 'group
sort' function. Select graphics and click 'group'-right click group - select 'group sort'.
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Machining control
CypCut integrates CAD and CAM functions, all operations including edit file

and set cutting parameters can be done in the office or your own computer. Then you
can open the file on machine for processing directly.

4.1 Coordinate System
Modeling coordinate designing graphic not relevant with the machine, zero point
marked by

.The coordinate referred in machining process and machine position

are shown below:

Click

in console will display the laser head position correspond with

graphic.

4.1.1 Mechanical Coordinate System
Mechanical coordinate of the machine is defined by the mechanism. Coordinate

system is consistent every time execute return origin

.
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CypCut defines coordinates with same rules no matter what mechanism applied.
Stand front of the laser head, laser head towards right is X+ direction, towards back is
Y+ direction which means the left bottom is the minimum coordinate.

4.1.2 Program Coordinate System
Mechanical coordinate is
consistent, CypCut also adopts
workpiece coordinate. Workpiece
coordinate X/Y direction same with
the mechanical coordinate system, only 0 point different and called program 0 point.
Program coordinate system is divided into floating coordinate system and workpiece
coordinate system.
Click the button above the console panel you can select 'Floating coordinate’,
'Workpiece coordinate' or 'external coordinate'.
Floating coordinates used in cutting samples or small quantity parts. Laser
head will start machining from current position.
If select workpiece coordinate, the zero point is manually set by users.
Workpiece coordinate applied for large quantity production. This will assure
machining starts from same position on the machine every time.
Click the status button
at bottom
screen.
You can select to display
mechanical coordinate or program coordinate and specify the zero point of the
coordinate. Select 'coordinate positioning' will locate the cutting head to the specified
coordinate position.

4.1.3 Find Zero Point after Interruption
Situation 1
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If machining process stopped by the accident but not affect coordinates, you can
click

return to zero point.

Situation 2
If accidents like power down or servo alarm stop the machining process and
deviate the coordinates, must execute return origin then click

locate to

zero point.
Situation 3
If the machining process interrupted by the
accident or misoperation, you can still locate to
the zero point of last machining process.
Click

in console panel and

select 'remember zero' then click 'go record’.
Software version required: CypCut V731 and
above.

4.2 Alarm
CypCut monitors all components when machine running. Once monitored an
alarm will stop the machining and display the alarm message in red title. Motion
function will be disabled until the alarm removed. Check the alarm source and
remove the alarm then resume the machining. The alarm title shown as below:

The 'Alarm' window at the screen bottom also display the alarm message. After
remove the alarm source the alarm title will disappear but alarm message in alarm
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window is recorded. Double click 'System' window can check all history records and
software events.
Besides alarm CypCut will display the warning, notice and important message in
different color once monitored abnormal process. These message won't stop the
machining but still suggest notice these information and take precautions in advance.
The alarm can be automatically or manually removed. In 'Layer-Global
parameter' window, at the right bottom there is option 'all alarm need reset manually'.
Below are restrictions once alarm activated:
Disable servo when emergency stop alarm activated (prevent accident
motion)
Disable X/Y motion functions when BCS100 alarm detected (under this
status, Z axis condition unknown, it might be collision if X/Y move)
Disable XYZ motion function when emergency stop alarm activated (in
complete stop status)
Z limit- alarm, disable dryrun and jog.
‘Move need confirm when BCS100 alarm’.
How to use :( Software version required: CypCut V731 and above)
1.

In configuration tool-Alarm, select options 'BCS100 alarm must be
acknowledged' and 'remove alarms manually'.

2.

If BCS100 alarm activated, at bottom screen will display

, click

will allow motor function again.

and
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4.3 Manual Test
The function buttons in console panel as shown below:

The button

will be in

once the function activated. Press

will

emit laser, release button will close laser; for other buttons, click the button activate
the function, click again close the function. For example, click

open the

gas, click again close gas. For different laser model, there will be a delay click
till it turns to

. This status accessed from laser unit. Click

will open guide/pilot laser.
Please take notice that each function realized by the related machine
components. Without hardware or settings are not correct in config tool, the function
button might not work.
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Click

to mark the current position, click

if you need to

locate to the mark position. Users can record 6 marks in total select in

.

4.4 Soft Limit Protection
CypCut provides software limit function. You can enable this function
in console panel.
When the system detect motion area will exceed the preset limit, it will prompt
message box to warn users and stop sending motion command to prevent collision.
Check the graphic one the drawing board make sure it's within the white frame.
System will monitor the current position in real time and stop the motor function
once detected exceed the soft limit.
Notice: Soft limit protection relies on correct coordinates. Therefore, every time
after change the machine config or system abnormal shut down happens users must
execute return origin to correct coordinates.

4.5 Frame
Click

laser head will move along the outline of the workpiece in a

rectangle frame to help users identify the machining position and workpiece
dimension on the plate. Frame speed is set in 'Layer-global parameter-frame speed'.
Notice: If the plate not up-right put on the machine bed and executed seek-edge
operation, frame direction is also not up-right.

4.6 Start and Dry Run
Click

start machining, there will be monitor of machining process

like coordinates, speed, time count and following height etc.
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When in above status cannot switch to other pages only File menu is available.
If you need to modify the parameter in the machining process must pause the

process then click the

button. Users can pause the machining and modify the

parameters in layer window, settings will take effect after resume the process.
Supported version: CypCut V731 and above.
Click

laser head will move along the actual cutting path with same

speed and acceleration but laser, gas and follow function turning off. Meanwhile
other functions like pause, resume, forward, backward and break point information all
same with the actual cutting. Dry run can used to check the machining process
without cutting the plate.
If you want to open follow function in 'Dry run', select

in

layer parameter window-global parameter.
By default setting, laser head will return to zero point after finish machining. If
you want laser head return to a specified
position you can set on console panel
including zero point, start point, end point,
origin and mark point. If
not selected, laser head will stand still at where finish the
machining. If you are using 'floating coordinate', it's recommended that select 'zero
point’. If you want laser head return to a mark point, select 'record&'.
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After a machining process completed it will add up 1 on 'Piece' at console panel.
When the 'Piece' reach the 'Plan' times it will prompt message to remind user. You can
set in

including target machining times and laser head actions after

machining process completed. If you need to cycle the machining click
and finish the setting.

4.7 Stop, Pause and Continue

Click

or

on console panel will stop the machining. Stop

the machining process, laser head will move to zero point. If you want laser head
stand still cancel the option
Click

or

on console panel.
on console panel can pause the machining process.

Meanwhile you can modify the parameters in layer window, or execute the functions
in console panel like burst laser, gas, turn on/off follow function etc.
Click

in CNC tool bar or

on control panel to resume the

machining process from interrupted position. Click

will resume the

machining process directly without piercing.
Click

or

to locate laser head backward or forward on

the machining path. The distance and speed of one step set on
at control panel.

4.8 Breakpoint
When the machining process interrupted by accident like power down, as long
as graphics and parameters related with machining process and sequence not been
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changed you can click

locate to the break point. Click

program will resume machining from break point.
If you change the machining parameters,
will turn to

button on control button

, under this status break point function will be not available.

4.9 Start at Specified Position
CypCut allow users start machining from any position of the graphic. Right
click on the graphic where you want to start machining and select
.As in the right picture:
For safety concern, select
, program will prompt dialog
box asks users to confirm operation. Then laser
head will locate to the specified position first, then
start machining.
If select

, laser head will

locate to specified position then come in pause
status.
You can execute

multiple times. Or you can adjust start

position by

4.10

.

Global Parameter

The parameters setting in 'Global Parameter' window will affect the machine
running condition, workpiece cutting performance and efficiency.
Below table lists part of the parameters.
Motion Control Parameters
Move speed

Dry run speed (different from cutting speed).
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Move acceleration

The max acceleration axis can reach in dry run.

Move Freq

The acceleration jerk of move acceleration.

Frame speed

Speed of frame-walk the workpiece outline.

Cut acceleration

The max speed axis can reach in cutting.

Work Freq

Acceleration jerk of cut acceleration in cutting.
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Default setting
PWM Freq

PWM signal frequency when burst laser.

Def Cur

The peak power when burst laser.

Def Pressure

Gas pressure when manual control the gas on console panel.

Gas delay

The gas delay in piercing process.

Initial gas delay

Extra delay when first time open gas after start-up the machine.

Switch gas delay

The time required to make sure old gas totally discharged and new gas
comes in when switch the gas.

Cooling pt delay

The time of blowing gas at cooling point.

Back after stop

When resume the machining process from pause status, laser head will
move back a distance.
Following parameter

Max follow height

There is limit of follow distance between nozzle and plate surface. If
the follow height larger than this value, Z axis will follow to this height
then lift up to the target height. This parameter is used to set the
maximum follow distance between nozzle and plate surface.

Frog style lift

Z axis moves in frog-jump style.

Enable follow in dry run

By default setting, Z axis not move in dry run. Select this option will
open follow function in dry run.

Disable follow

Select this option follow function will turn off in machining process.

Only positioning

Applied in nun-metal material cutting, select this option it will disable
follow function in machining.
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Unlift when move distance

If in layer setting select 'short move', when the dry run distance shorter

less than

than this value, Z axis will not lift and stay at cut height.

Unit switch

Select the unit system by user’s habits.
Advanced

Enable NURBS spline

Select the option can smooth the graphic curve and improve cutting

interpolation function.

speed.

Pierce and film setting

Set details in 3.13.3.

All alarms need reset

All alarms need to be reset manually

manually
Enable machine

Hide some parameters which will affect the machine service life if set

protection

improperly.

Compensate precision

Precision of compensating cut seam.

Fly cut over distance

Extra cut distance at graphic end point. This will assure the whole
graphic will be cut down.
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5.

CNC Assistant Function

5.1 Simulation
Users can simulate the cutting process check the cutting sequence in program.
This process executed only in software, not sending any commands to the
machine. By simulating the machining, users can check the sequence between parts
and in parts.
Click

in control panel, it will switch to 'CNC menu automatically,

you can adjust simulating speed in tool bar.

5.2 Find Edge
CypCut supports three patterns to find plate edge: BCS100 find edge,
photoelectric sensor or manual locate edge. Click ' ' drop down menu you can select
the find-edge pattern to locate plate position and edge. Find edge result will be
displayed on the top right area of drawing board.

5.2.1 BCS100 Find Edge (Open in Platform Configuration Tool)

Click

drop down menu select

will open BCS100 find

edge parameter window.
Plate size X is the plate length in machine X direction; plate size Y is the plate
length in machine Y direction. The 2nd and 3rd point position to locate the plate edge
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is calculated by the plate dimension, it's suggested that input value little smaller than
actual dimension to avoid laser head crash in machine teeth.
Margin: Find edge result will determine a 0 point of plate. This margin can

adjust the 0 point inward or outward the plate. If you have set plate margin in nesting
plate then you can input 0 here.
6-point find edge: This recommended to use on thin plate. Laser head will execute 6
times find edge actions to reduce the interference of machine teeth.

'From starting point'-you can set a fixed position then find edge will start from
this position every time. You can locate the laser head at a fit position as start point to
find edge. This position must be within the plate.
'From current position'-laser head will start find edge from current position.
Please make sure laser head is within the plate.
If select 'find edge before working', it will execute find edge before start machining.
Notice: Before execute find edge function, make sure laser head can follow to the

material properly. The inclination angle of the plate should not exceed 10 degrees.
Find edge parameter window shown as below.
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You can also set more detailed actions click bottom button

.

Find edge speed affects the accuracy of result, recommended 100mm/s；
'Follow height' is distance between nozzle and plate in find edge process,
recommended 4mm；
'Adjust value' is to offset the find edge result inward or outward the plate;
'Rack dif' is the gab betwen machine teeth tip.

5.2.2 Infrared find edge (photoelectric sensor, open in platform
configuration tool)
The photoelectric sensor support Omron E3Z-L61.
If use infrared find edge function first time, measure the horizontal distance
between sensor and laser beam. Before execute find edge, locate laser head to the start
position (top left, bottom left, top right or bottom right).
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It’s required parameter setting to start this function. The coarse locate speed is
recommended 100mm/s; Precise locate speed will affect the accuracy of result,
recommended 10mm/s and no more than 30mm/s. Locate the edge with slower speed
will get more precise edge result. Plate dimension and 'edge correction X/Y' same
with BCS100 find edge setting.
Advanced settings will reduce the machine tooth tip interference and offset
between sensor and laser beam.
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You can set the following parameters ‘Y deviation’ is the horizontal distance

between sensor switch and laser beam accessed by program automatically; ‘Brace bar
thickness' (tooth thickness) reduce the machine tooth effect to the sensor; ‘Seek height' used

under scenario that sensor switch mounted on the laser head. Users can jog Z axis up
or down to adjust the sensor position and set as 'seek height’. Each time start find
edge it will locate to this position.
Notice: The inclination angle of the steel plate should not exceed 40 degrees.

5.2.3 Cut Off (open in platform configuration tool)
Open this function it will show options under ‘Seek edge’ drop down menu. This
function used to split plate.
Cut off safe distance: Laser head starts from
outside plate in a fixed height after pass this distance
will follow to plate.
X cut off (left to right): Select this option when
execute split-plate function, laser head will follow
out of the plate then cut in from left side, then follow
out of the plate cut in from right side.
Notice: When split plate it should use parameter

of green layer.
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5.3 PLC Process

Click

in 'CNC' menu users can edit and execute PLC process.

Notice: Inappropriate PLC settings can lead to serious consequences! Please
contact our technicians if you have any doubt.

5.4 Return Origin Point
5.4.1 Return to Mechanical Origin

You can click

in CNC menu to return axes to mechanical origin and

rebuild coordinate. See details in section 'coordinates’. Click
axis will return origin separately. If you select

or
or

program will execute the actions when return axes to origin.

5.4.2 Gantry Synchronization
For the machine with gantry design, some problems
mounted parallel, friction or load
different, will cause gantry position error
affects cutting precision. System will
record the Y1/Y2 Z-signal position at
mechanical origin, then offset the Y axes
position error.
Click Go origin drop down menu
and select

.

like two Y axes not
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After finish gantry synchronization select the option
.The offset message will show in system window
at bottom screen.
Notice: Once modified the machine structure it must execute gantry
synchronization again.
Details of operation see in appendix.

5.5 Optical Path Setting

If you need to locate laser head to a specific position, click

menu and input coordinates in

in CNC

.

CypCut can also assist interferometer to measure the mechanism offset.

5.6 Diagnosis Window
Users can click

to check all signal status in machining process to

debug.

It also monitors signals of each axis and encoder feedback. Users can send pulses to

any of these 4 axis and check if pulse equivalent set right by comparing encoder
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feedback. Limit signal activated means laser head hit limit switch or other situation
trigger the limit sensor. PWM monitors laser status of turning on or off. It also monitors
signal terminal status of 15 inputs and 20 outputs.
'Encoder analysis' can check if encoder feedback same with the motor rotation.
Some functions require consistency of the encoder feedback and motor rotation.

5.7 BCS100
This function requires BCS100 controller. Users can control BCS100 controller
in CypCut software in

including return axis to origin, follow to plate, locate

axis to specified position and calibration etc. Users can also do BCS100 settings
through software.

5.8 QCW
QCW is a laser working mode. Laser working mode contains CW and QCW.CW is

continuous wave and QCW is pulsing type. Click
laser mode.

to set the parameters related this
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5.9 Measure Deviation

Click

laser head will run through the graphic. Then program will display a

dotted line in blue calculated by the motor feedback. Users can compare the reference path
with the feedback path to adjust the related parameters to reduce deviation.

5.10

Clean Nozzle (open in config tool)

Open the function in config tool-auto clean

it will show in

CypCut-CNC column 'Clean nozzle' function button.
Instructions:
Jog laser head to brush and set Z position (nozzle should be on the brush).
Users can select if blow gas when clean nozzle.
Laser head can move in straight line, circle or wave pattern to clean nozzle.
Select the pattern in 'adjust setting' .After finish the setting click 'Ok' will start clean
nozzle.
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6.

Appendix

6.1 Co-edge Example
Below is a real example of a customer's part
graphic setting co-edge. The original DXF is on
the right side.
The graphic in red line is unclosed created in
CAD.
You can briefly tell that there are 6 bigger
parts and 10 long strip parts at bottom and 9*2=18
short strip parts at right side.
First, separate these 3 parts .As shown
below:

Then group the graphic as three single parts.
Select part 1 array in 3*2 pattern.
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Select the arrayed parts and click

will finish the co-edge of these 6

parts.
Select part 2 close to part 1, it will attach to the part 1.As shown below:

Select part 2 array by 2*9 will get the result
as in right picture.
Select these 18 parts.
Click

will finish the co-edge of

part 2. The cut sequence of part 2 must from right
side to the left side, otherwise the workpiece will

deviate for lack of holding force.
Right click part 2 select
'group sort-right to left’. As
shown below:

You might be curious about
why attach the part 2 with part 1 then co-edge the part 2.
The order can be switched. Next we will co-edge part 3 then attach the part 3 to
part 1.
Select part 3 and array by 10*1 then we get below result:
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Select all part 3 click ' ' will co-edge part 3.As shown below. Take notice that coedge part outline is different. After finish the co-edge of all parts, the frame of whole
object shown in bolder line.
When the cursor point on the graphic it will show the message indicates it's a
group.

Cut sequence of part 3 also should be from bottom to top.
Select part 3 attach to part 1.As below:

Then you can co-edge all parts.

If you don't need part 1/2/3 co-edge then pass this step.

6.2 Gantry Synchronization
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6.2.1 Platform Configuration

Gantry synchronization function should be open in config tool
1) Platform config tool - > Machine - > select 'Dual drive'

2）Platform config tool - > Return origin - > select 'Z signal'

.
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2) Platform config tool - > Alarm - > input "gantry deviation tolerance”.
When the gantry deviated by crash or other reason exceed this value you
should check the machine parts. You can set the value as needed.

6.2.2 Gantry Initialization and Synchronization
Before start gantry initialization, please confirm that following items:
1. The gantry is been corrected deviation.
2. Axes motor functioned normally.
3. Origin switch works normally.
4. Z-phase signal pin wiring correctly.
5. Encoder feedback pulse set right. You can check pulse feedback in diagnosis
window-card monitor.
Open CypCut main program, in CNC-Return Origin
drop down menu, click

.

It will execute return axes to origin, then get Z phase
signal of Y1/Y2 axis. After return origin, it will show Z
phase signal difference (Y2-Y1 offset) at bottom screen.

89 / 103

90 / 103

Friendess CypCut Laser Cutting Control System

After finish gantry initialization, select

input

password and save the setting.
Then every time execute 'Return origin' or 'Y return origin' system will compare
Z signal position difference and add offset. The details will show in system window
at bottom screen.

6.2.3 Notice
1. This function requires Z phase signal.
2. Once machine structure modified, must execute gantry initialization.
3. When the gantry deviated visibly from big mechanical shock, you have to
adjust the gantry mechanism and execute gantry initialization.

6.3

BCS100 Find Edge Instructions
CypCut6.3.712 and above improve the find edge function in precision of

locating plate edge. This requires BCS100 V3.0.3299 and above.BCS100 V2.0
doesn't support new function.

6.3.1 Platform Configuration
Open config tool, enter find edge page and select

.
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.

6.3.2 Single Point Find Edge

For example if select left direction:
1） Laser follows to plate and starts find edge in left direction.
2） Laser head lifts up.
3） Laser head returns back in right direction and stop at plate edge.
4） Laser head lift up and stops at dock position.
5） Find edge process complete.
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6.3.3 Three-Point Find Edge

Here is an example that reference point is at bottom right.
1) Input plate dimension. The plate dimension should be same or little smaller
than the real plate.
2) Locate the laser head to the bottom right on the plate.
3) The program will get position A/B/C by the current position and plate
dimension.
4) Laser head will move in Y- direction and get X1;
5) Laser head will moves to B;
6) Laser head will move in Y- and get X2;
7) Laser head moves to C;
8) Laser head moves in X+ direction and get Y1;
9) After program finishes find edge process, it will calculates angle θ and
define 0 point at bottom right corner of plate. Laser head will locate to the
0 point.

6.3.4 BCS100 Find Edge Notices
1.

Before start BCS100 find edge function, it must execute return axes to
mechanical origin to build correct coordinate.
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2.

Open CypCut-Diagnosis-Card monitor check the encoder feedback that must be
same with command pulses.

3.

Plate dimension setting should be same with the real dimension.

4.

The inclination angle of the steel plate should not exceed 10 degrees.

5.

Before start find edge, it should set reference point as top left, top right, bottom
left or bottom right, otherwise it's not available for find edge function. Reference
point defines the direction that laser head starts to find plate edge.

6.

You have to locate laser head within the plate before start find edge function.

7.

You have to make sure laser head can properly follow to the plate.

6.4 Infrared Find Edge
CypCut V6.3.642.6 and above support find edge by photoelectric sensor.The
photoelectric sensor support Omron E3Z-L61.

6.4.1 Photoelectric Switch

The effective working range of the photoelectric switch is 90 +30 mm.
Installation thread is M3; the switch can switch into 2 modes. Switch to L lights on
when outputs signal, and switch to D lights off when outputs signal. Spin button can
adjust the sensitivity of the switch.
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6.4.2 Wiring and Configuration

Open the config tool and click into 'Find edge' page on the left sidebar. Select
'enable optical'.
The 24V+ power line of brown connected to
the thyristor output terminal on IO board, 24Vpower line of blue connected to the COM terminal
on IO board, black line connected to input terminal
on IO board.
The signal logic of switch must be consistent in
CypCut config tool and actual mode of switch. L mode is recommended.
If the machine mounted with exchange table also select 'separate seeking height
for pallet'.
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6.4.3 Three-point Find Edge

1）The first time use 3-point find edge function you have to measure the offset in
horizontal direction between switch and laser head center;
2）Open the guide laser and locate the laser head at bottom right on the plate;
3）Select 'bottom right' under 3-point find edge drop down menu;
4)

Acquire point A and point B by the plate length and width;

5) Locate to point A;
6)

Find edge in Y- direction and get X1;

7) Locate to point B;
8)

Find edge in Y- direction and get X2;

9) Locate to point A;
10) Find edge in X+ direction and get Y1;
11) Find edge process complete, program will calculate plate inclination degree θ,
and laser head will locate to 0 point on the bottom right plate;

6.4.4 Precautions
1） Open CypCut-Diognosis-Card monitor check the encoder feedback that it
must same with command pulses.
2） When you adjust the switch sensitivity make sure the green indicator
always turns on.
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3） The setting values of plate length and width are consistent with the actual
dimension.
4） The inclination angle of the steel plate should not exceed 40 degrees.
5） In test page it's available to customize a find edge position. But in actual
practice it must to set the reference position as top left, bottom left, top right
or bottom right so program can identify the find edge direction.
6） The first time use 3-point find edge function you have to measure the offset
in horizontal direction between switch and laser head center.
7） When execute find edge, you have to locate the guide laser within plate.

6.5 Regional Output
In CypCut config tool- Outport page you can set regional output for dusting.
Select 'Area output' set the lines and columns. Drag the boundary line can change the
area of each zone. You can assign output to each zone.
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6.6 Motion Parameter Adjustment
6.6.1 Motion Control Parameter
CypCut opens motion control parameters including speed, acceleration, lowpass filter, corner and curve precision etc., to users. Other parameters related with
motion performance has been optimized automatically. The description of parameter
is shown in the following table:
Name

Description

Move speed

The max dry run speed. You can set this value according the result
calculated by the ServoTool.
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Move

The max dry run acceleration. You can set this value according the

acceleration

result calculated by the ServoTool.

Cut

Maximum cutting acceleration directly determines the time required

acceleration

of ACC/DEC in corner motion. You can adjust this value by
observing servo torque curve.

Low-pass

Smaller value will improve the vibration suppression but extend the

filter

ACC/DEC time.

frequency
Curve

The max precision in curve machining. The lower the value is, more

precision

obvious in speed limit at curve machining.

Corner

The precision of NURBS curve fitting the corner path. The lower

precision

the value is, corner path will be sharper and speed reduction more
obvious.

6.6.2 Cut Acceleration
Jog axis at a high speed, 500mm/s for example, make sure axis move a long
distance and reach the set speed.
Monitor the torque curve in servo tool when jog the axis, increase the work
acceleration if peak torque under 80% or reduce work acceleration if peak torque
larger than 80%.
Adjust the acceleration until top torque reaches to 80%.The acceleration lead
screw structure can bear is usually no more than 0.5G.The acceleration gear rack
structure can bear is no more than 2G.

6.6.3 Move Acceleration
You can set this value according the result calculated by the ServoTool. Or larger
than work acceleration by 1.5~2 times of it. When axis running without load, servo
torque should be within 150%, and there is no mechanical deformation and vibration
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under this acceleration. The acceleration lead screw can bear usually no more than
0.5G.And usually no more than 2G for rack gear structure.

6.6.4 Low Pass Frequency
Adjust low-pass filter by cutting a workpiece sample. Set a small laser power
marking on plate and observe the cutting path. The sample graphic could be small
circle in different sizes, hexagon, dodecagon, star shape and rectangle. As shown in
the following figure:

Increase the low pass filter as much as possible without affecting the cutting
precision. The reference standard of test cutting is no waves around the corner in
rectangular, star type cutting. You can setup as the experiential value in below table.
Or you can setup the cutting acceleration then adjust the low pass filter frequency up
and down within 2 levels. The cut acceleration and low pass filter frequency must
match, does not setup a large value and the other too small.
Level

1

2

3

4

5

6

7

8

9

10

0.1

0.2

0.3

0.4

0.5

0.6

0.8

1

1.5

2

3

3.5

4

5

5.5

6

6

6

7

8

Cut
Acceleration
(G)
Work
frequency
(HZ)
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6.6.5 Arc and Corner Precision
Only under special circumstances to adjust the parameters in a small extent
around the default value, otherwise not recommend to modify these two parameters.
If curve precision parameter set too large and cutting precision is not good, you
can lower the curve precision which will limit the cutting speed at curves. If sharp
corner precision is not good, lower the corner precision will limit the cutting speed at
sharp corner. The value set too large the sharp corner will turns to a round corner.

6.7 Shortcut Key
The following table lists the shortcuts commonly used in CypCut, some of
which need to be used in specific circumstances. They have been introduced in
relevant chapters, and are not listed here.
Shortcut Key

Effect

Using conditions

Ctrl + A

Select all graphics

None

Ctrl + C

Copy graphics to clipboard

Select the graphics to operate on

Ctrl + Shift + C

Specify baseline copy command

Select the graphics to operate on

Ctrl + O

Open file:

None

Ctrl + P

Display/Hide graphic direction and move

None

path
Ctrl + V

Paste clipboard graphics to drawing board

There are copied graphics in the
clipboard

Ctrl + W

Adapt the window

None

Ctrl + X

Cut graphics to Windows clipboard

Select the graphics to operate on

Ctrl + Y

Redo the order just revoked

There are revoked orders

Ctrl + Z

Revoke the order just completed

There are completed commands

F2

Open the Layer parameter window

None

F3

View all graphics

None

F4

View the whole range of machine tools

None
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Shortcut Key

Effect

Using conditions

F7

Display/Hide machining path

None

F8

Display/Hide move path

None

DEL (delete)

Delete selected graphics

Select the graphics to operate on

SPACE (Space)

Repeat the previous command

The last command is repeatable

6.8 Burn Test
Newly installed machine required aging test to confirm the running
performance. How to open this function: File - > Diagnose - > Burn test

The actions to test the machine listed below:
XY axis running on machine bed in full range at different speed in 2-48
hours to verify the reliable performance of motor function.
Z axis continuously lifts up and down to test the stability of motor
function. Execute return origin multiple times to verify the limit switch
reliability.
Z axis motion test without laser head axis moves between A to B position,
it has to shield the capacitance alarm.
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Z axis motion test with laser head: Z axis moves between A to B position.
Do not shield BCS100 capacitance alarm, this is a protection for laser head
collision.
Z/XY motion test executed at same time.

